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1 Introduction

This guide accompanies the open source DisGUVery software, a Python-based application to detect and
analyse Giant Unilamellar Vesicles (GUVs) in microscopy images. This Quick User Guide serves as a set of
quick instructions to get started with DisGUVery. The code is available in the Github repository, and will
soon be followed by a full documentation.

Throughout this guide, code is written in verbatim as are software functions, [software menus] are
in verbatim between brackets, quick instructions are displayed in cyan boxes and troubleshooting tips are
given in magenta boxes. To help you get started with the software, we show example images and multiple
possible analysis pipelines in this user guide. The same images and the corresponding analysis workflows are
also available in the repository in the folder Training Data, with which you should be able to reproduce
the analyses shown here.

We welcome any questions about the use of DisGUVery, as well as bug reports and suggestions for im-
provement, both for the software and for the user guide. Please post your questions, remarks or suggestions
in the appropriate issue boards in the Github repository.

We wish everyone a fruitful and enjoyable image analysis with use of DisGUVery!

Lennard and Cristina
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2 Getting started

2.1 Download

Download the files from the Github repository and extract the files to a folder of your liking (typically this
folder will be called disguvery-main). There should be a folder called disguvery and in this folder you
should now see a selection of python scripts, including disguvery.py.

2.2 Setting up

The software does not need to be installed, but can be started right away. To launch the program, start the
command window and navigate to the folder where the code is saved. Then, the software can be started by
calling the disguvery.py file using the python command. For example, in Windows if we are working on
the D: drive, where we have the folder of disguvery-main, we can type:

>> C:\> cd master-disguvery

>> C:\master-disguvery> python disguvery.py

Note: if you start your command prompt or terminal in another drive, e.g. C: , just type D: in the
terminal to change to drive D:

When running the software for the first time, you might encounter that some required packages are miss-
ing or not up to date. Use pip to install missing packages and to update outdated packages. If you need to
change your packages versions, and/or install anything new, we recommend to create a virtual environment
with the requirements for DisGUVery as to not interfere with your normal installation. You can find a
step-by-step guide below.

2.3 Installing required packages on a virtual environment

To create a virtual environment, navigate to the disguvery-main folder and type:

>> D:\disguvery-main> python -m venv disguvery-env

where disguvery-env is the name of the virtual environment we are going to dedicate for working with
DisGUVery. Here, you will have a ’clean’ installation of python where you can install only the packages
that are required for DisGUVery to run. Before you can work in this virtual environment, it needs to be
activated:

>> D:\disguvery-main> .\disguvery-env\Scripts\activate

Now we can install the required packages, listed in the file requirements.txt:

>> D:\disguvery-main> python -m pip install -r requirements.txt

This will install all the packages in the specific versions that were used during development and testing.
You’re now ready to use DisGUVery!

2.3.1 Activating and deactivating the virtual environment

Once you’re done working with DisGUVery, you can deactivate the environment by typing:

>> D:\disguvery-main> deactivate

Next time you want to use DisGUVery, it is only necessary to activate the virtual environment where the
installation was done. Don’t forget to navigate to the right directory to launch DisGUVery:

>> D:\disguvery-main> .\disguvery-env\Scripts\activate

>> D:\disguvery-main> cd disguvery

>> D:\disguvery-main\disguvery> python disguvery.py

4

https://github.com/DisGUVery


2.3.2 Requirements

pillow==9.0

numpy==1.22

matplotlib==3.5

opencv-python==4.5.5.62

scikit-image==0.19

ttkthemes==3.2.2

2.4 Graphical User Interface (GUI)

As soon as the program is launched, the main graphical user interface (GUI) will appear (fig. 1). While all
operations are executed in the GUI, it is good to keep an eye on the terminal as messages and errors will be
printed there.

The major functionality classes can be found in the top of the GUI window, consisting of File, Image Options,
Vesicle Detection, Membrane Segmentation, Analysis and Batch Processing. The File menu contains
basic options including loading an image or a set of images. In Image Options, you can find general options
to work with different colour channels. Under Vesicle Detection, you can access the three methods to
detect vesicles in the image as well as image preprocessing options. The Membrane Segmentation menu
contains two methods to segment the vesicle membrane, for the purpose of inspecting fluorescent signal
inside the vesicle or close to the membrane. Then, the Analysis menu contains multiple modules to perform
standard image analysis using the vesicle detection results. These modules include simple analyses such as
extracting a distribution of vesicle sizes or internal fluorescence of vesicles, but also generation of intensity
profiles. Finally, the Batch Processing menu contains options for high-throughput analysis on larger num-
bers of files.

2.5 Opening an image

To load an image, use the menu File -> Open Image. A file dialog opens where you can browse through
the directories to find and select your image. The program accepts TIF, TIFF and PNG images with ex-
tensions .tif, .tiff or .png. An overview of input and output options are found in section 8. Note that
by default only TIFF images are shown in the browsing window. To switch between the two extensions,
use the dropdown menu in the bottom right corner. Select Open to open the image in the GUV toolbox
window. The selected image is now displayed in the GUI (see fig. 1c). This is accompanied by a message in
the terminal, stating the number of colour channels identified for the loaded image.

Quick Instructions 2.1: Loading an image

File - > Open Image

Make sure you select the right extension (.tif or .png).

Instead of loading a single image, also a set of images or an entire folder can be opened to speed up
analysis. To open multiple images, select Load Multiple Images, and select the images of interest while
pressing Ctrl. To open all the images in a folder, choose Load folder. All the files with recognized
extensions will be loaded in the software.

2.6 File manager

You can navigate through loaded and processed images with the File Manager. Go to File -> File Manager

to open the File Manager (see fig. 2). In the left list Available Directories you can find the directories from
which images have been loaded. In the right list Available Images, you will see the loaded images from the
selected directory. You can inspect images by selecting an image from the list and clicking Preview. To set
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(a) Empty GUI (b) Loading an image

(c) Image displayed in GUI

Figure 1: Getting started. The GUI and loading an image.

another image as the Current Image, click on the image in the right list and click Set as Current. The
Current Image is the active image on which all the selected actions are executed. After setting an image as
the Current Image, the colour of its name will switch from black to green. To delete images from the set
of loaded images, select the image from the Available Images and click on Remove Image. Its name is then
erased from the list.

Known issue: In the current version 1.0, navigating in the File Manager between different directories
is not enabled yet. This is flagged for improvement for new releases.
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Figure 2: File manager for navigating between loaded images

3 Image Options

3.1 The image toolbar

Above the window canvas, an interactive toolbar can be found which contains several basic options for
display fig. 3 (appearance of the toolbar can depend on operating system and matplotlib version). Full
documentation can be found on the website of matplotlib.1

Figure 3: Toolbar for basic image operations

From left to right, the buttons are:

� Home: Resets to original view.

� Back: Go to previously defined view.

� Forward: Go to next defined view.

� Pan/zoom: Press and hold the left mouse button to pan the figure and drag it to a new position.
Particularly useful for template selection (section 4.2.2).

� Zoom to rectangle: Press and hold the left mouse button, and drag it over the screen to define a
rectangular region to zoom in on. Useful for template selection (section 4.2.2) and inspecting vesicles.

� Configure subplots: Change spacing of subplot layout.

� Save figure: Save the currently displayed figure with one of the extensions png, ps, eps, svg, pdf.
The image is saved exactly as it is being displayed, including e.g. detection results and processing
results.

3.2 Channels

Multi-channel images with up to four colour channels can be loaded and processed with the GUV toolbox
software. Multi-channel images should be of the format (x, y, c), where x and y are the width and height
of the image, and c is the number of different imaging channels. By default, a composite of all available
channels is displayed in the main window.

1https://matplotlib.org/3.2.2/users/navigation toolbar.html
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3.2.1 Channel display

To change the display channel, go to Channels and select one of the available imaging channels. The selected
channel will now be displayed. The information of the other channels is stored in the software and will still
be accessible for later analysis.

Note that image preprocessing and vesicle detection are always performed on the channel that is selected
and displayed. It is thus important to first select the channel that should be used for vesicle detection, and
only then start with preprocessing and vesicle detection.

3.2.2 The channel manager

Colour channels can be assigned to different labelled structures. This allows you to perform specialized
analysis for different structures in your sample, such as analysing membrane-bound signal versus encapsulated
content. To open the Channel Manager, go to Channels -> Open Manager (fig. 4). The colour channels
(up to four) can be assigned to one of the following imaging conditions:

� Membrane signal: the channel used to image the membrane label. This channel will by default be
used for vesicle detection (see section 4). In the calculation of angular intensity profiles (see ?? 6.2),
the integration for membrane signal will be limited to the region around the membrane.

� Membrane-bound: for components that localize to the membrane to some extent. Angular profiles of
membrane-bound signal are also limited to the region around the membrane.

� Encapsulated content: signal that is dispersed through the vesicle lumen. Encapsulation Analysis
is by default performed in the Encapsulated Content channel (see section 6.2). Angular integration of
encapsulated content is performed over the entire vesicle lumen instead of only in the membrane region
(see above).

� Brightfield: non-fluorescent signal. No special functionalities.

� Other: other.

Figure 4: In the Channel Manager, you can assign colour channels to different labelled structures.

3.3 Reset image

At any time during image processing, you can go back to the original, unprocessed image. To do so, click
Reset Image or press Ctrl + r. You will see the original image being displayed in the main window.

Quick Instructions 3.1: Image reset

-> [Image Options] -> Reset image (Ctrl + r)
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4 Vesicle Detection

4.1 Image preprocessing

The software includes two basic image preprocessing steps that can improve speed and accuracy of vesicle
detection. Dependent on image properties, such as signal to noise ratio and vesicle density, and on the
chosen detection method, image preprocessing needs to be tuned. Preprocessing is optional, but highly
recommended for Hough and Floodfill detection.

To enter the preprocessing options, open the Membrane Enhancement window under Vesicle Detection

(fig. 5a, fig. 5b). We advise to first switch to the channel that you want to use for vesicle detection before
starting preprocessing.

Preprocessing consists of two steps: smoothing and enhancement. Set the Smoothing Filter Size (in
pixels, 15 by default) and click Smooth Image. The displayed image is updated automatically, and will show
the smoothed image (fig. 5c). Then, enhance the membrane signal by specifying Enhance Filter Size (in
pixels, 45 by default) and click Enhance Signal. Again, the displayed image is updated automatically to
show the enhanced image (fig. 5d).

(a) Opening the membrane enhancement menu

(b) Enhancement options

(c) After smoothing (d) After enhancement

Figure 5: Preprocessing workflow of an epifluorescence image of vesicles. The membrane enhance-
ment panel is opened (a) and contains multiple settings for preprocessing (b). Typical preprocessing is done
by first smoothing (c), followed by edge enhancement (d). Finally, image preprocessing should result in
well-defined vesicle contours.
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It might be necessary to play around with different preprocessing settings to see which give the best
results for vesicle detection. For smoothing, one typically requires small filters to remove random Gaussian
noise. Large filters are used to remove large scale intensity noise, such as inhomogeneous illumination or
intensity variations as an effect of a varying vesicle density throughout the image.

Quick Instructions 4.1: Image preprocessing

Vesicle Detection -> Membrane enhancement

[Membrane Enhancement] -> Select detection method

[Membrane Enhancement] -> Smooth Image

[Membrane Enhancement] -> Enhance Edges

Preprocessing settings can be set and stored for each vesicle detection method individually. To do so,
go to Membrane Enhancement and from the drop-down menu, specify the vesicle detection method that you
want to set the processing settings for. Try which filter sizes work best for preprocessing and save the settings
using the Save button. These settings can later on directly be accessed from the Detect Vesicles module,
without needing to re-open the Membrane Enhancement panel.

4.2 Detection methods

Vesicle detection can be done with one of the three methods: Circular Hough Transform, Multiscale Template
Matching, and Floodfill Detection. All three detection methods can be found under [Vesicle Detection] ->

Detect Vesicles. In this section, we will explain how to use the different methods. For more informa-
tion, we refer you to the original paper, the documentation in the Github repository and the OpenCV
documentation2 on which several functions are based.

4.2.1 CHT: Circular Hough Transform

The Circular Hough Transform detection detects circular objects in an image. To use the Circular Hough
Transform, it is important to first preprocess the image. Preprocessing drastically reduces the number
of edges and false edges in the image, thereby making CHT not only faster, but also more accurate. To
preprocess the image, enable both Smoothing and Enhancement. Note that preprocessing executed from the
Vesicle Detection window will use the settings specified in the Membrane Enhancement window (see also
section 4.1).

After preprocessing, you can run the Hough Detection by pressing Run. When detection is completed,
the detected objects are displayed on top of the working image in the main window (fig. 7). You can show
or hide the detected circles using Show Detection/Hide Detection. To toggle between the original image
and the working image, press Original/Current Image.

Quick Instructions 4.2: Circular Hough Transform detection

[Vesicle Detection] -> Detect Vesicles

[Vesicle Detection] -> Hough Detection

[Vesicle Detection | Hough Detection] -> Enable Smoothing & Enhancement

[Vesicle Detection | Hough Detection] -> Run

In the Hough detection panel (fig. 6b), there are five parameters that can be tuned for detection:

� Edge Threshold: This number sets the threshold of edges that should be used for object detection. If
many vesicles are not detected, try to decrease this threshold to include more edges in the detection
step. If you have many false positives, increase this number to only keep higher quality edges. Be
aware that substantial lowering of the edge threshold can significantly slow down detection, as many
edges will be included in the Hough transform.

2https://docs.opencv.org/
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(a) Opening the Hough Detection menu
(b) Hough Detection settings

Figure 6: Workflow for CHT detection. Open the vesicle detection menu and the Hough detection tab
(a). Here you can find the settings relevant for CHT detection (b).

� Hough Threshold: The Hough threshold can be seen as a circularity criterium. Increasing the Hough
threshold allows you to only keep objects with high circularity, while decreasing the Hough threshold
will lead to inclusion of less circular objects.

� Min. distance: The minimum distance between two detected objects (in pixels). This parameter is
especially important to avoid detection of ’secondary’ vesicles, see the Troubleshooting section below.
These secondary vesicles can appear as an artefact of the Hough transform.

� Min. radius: Lower limit of vesicle sizes to be detected (in pixels). Narrowing down the size range
can speed up the detection, and also improve accuracy.

Figure 7: CHT detection results. Detected vesicles are indexed and assigned with circles.
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� Max. radius: Upper size limit for detection (in pixels).

Troubleshooting 4.1: CHT detection

� Computation time is long. The CHT computation time can increase dramatically when
the parameter space for Hough detection is too large. When this happens, the software can
get stuck during detection. In that case, close the software, and retry detection with a more
narrowed down parameter space. First, try to create an edge enhanced image with edges that
are visibly smooth. Then, try detection with higher Edge Threshold, Hough Threshold and
Min. distance. It is better to start with these parameters set too high to allow fast detection,
and from there lower all three parameters to maximise the number of true positives.

� No vesicles are detected. When no vesicles are detected, detection criteria are set too strict.
Try to decrease Edge Threshold and Hough Threshold and make sure that Min. radius and
Max. radius represent the lower and upper limit of vesicle sizes.

� Secondary vesicles are detected. Even when the object of interest is detected properly,
smaller false positives with a lower detection score can be detected just around the object of
interest (fig. 8). By increasing Min. distance, secondary vesicles close to the true vesicle can be
discarded while the object with highest detection score is retained. Otherwise, Edge Threshold

and Hough Threshold can be increased to keep only the objects with the highest detection score.

Figure 8: With lower Hough and Edge detection
thresholds and a larger minimum distance, CHT
detects secondary vesicles.

To improve your detection results, you can try to tune either the Hough detection parameters or the pre-
processing settings. Do not forget to reset the image after multiple preprocessing trials. Resetting the image
is not required in between multiple detection trials. When you are satisfied with the detection outcomes,
you can store your results internally in the software by clicking Save.

4.2.2 MTM: Multiscale Template Matching

Detection with Multiscale Template Matching is essentially a comparison of a template, i.e. the object of
interest, with the image. Scaling of the template to a range of sizes allows for multiscale detection with a
single template.
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Quick Instructions 4.3: MTM detection

[Vesicle Detection] -> Multiscale Template Matching

[Template Matching] -> Enable Smoothing & Enhancement

[Image Toolbar] -> Zoom in on template

[Template Matching] -> Set

[Template Matching] -> Run Detection

Detection with MTM is very intuitive. After loading the image, open the template matching tab in
the vesicle detection menu by clicking [Vesicle Detection] -> Template Matching (fig. 9a). The MTM
control panel opens automatically in a new window (fig. 9b). Preprocessing is optional.

(a) Choose MTM detection
(b) MTM panel

(c) Select template (shown with orange box) (d) Inspect and set template

Figure 9: Template selection for MTM detection. First, choose the Template Matching tab from the
Vesicle Detection menu (a). The MTM tab opens up (b). Activate the zoom button on the toolbar (c, orange
arrow) and zoom in on a vesicle that can be used as a template (c, orange box). Fine-tune your selection
with the panning and zoom options (d, orange arrow). Once you are happy with the result, set the template
(b).

First, a template needs to be selected. You can create a new template directly from the image (fig. 9c),
or load an old template. To create a new template, first use the Zoom icon in the upper toolbar. Locate a
vesicle that can be used as a template for detection. This should be a vesicle that resembles your vesicles
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of interest, and that is well-separated from other vesicles. The size of the vesicle does not matter as the
software allows for rescaling. Zoom in on the template vesicle by dragging a rectangle over it. You can
fine-tune your template selection by using the Panning and Zoom options. When you are happy with the
result, you can assign the vesicles as the template by pressing Set template (fig. 9d). You can also save
your template by clicking Save template. Likewise, you can load older templates using Load template.
Inspect your template by clicking Show template, which will open a new window.

Figure 10: MTM detection results. Vesicles of varying size have successfully been detected with multi-
scaled template matching. Detected vesicles are indicated with yellow bounding boxes and index number.

When you have your template, you are almost ready for detection. You can now modify scaling options
and the matching threshold:

� Min. resize: The smallest scaling factor to be used. A Min. resize of 0.5 means that the template
will be scaled to half its original length and width. So, when your template object is twice as large as
the smallest object that you want to detect, use a minimal scaling factor of 0.5.

� Max. resize: The maximum scaling factor that will be used.

� Number of scales: The number of different template scales that will be used for detection. The soft-
ware creates a linear distribution of Number of scales scales ranging from smallest size Min. resize

to largest size Max. resize. The default number of scales is 10. In general, a higher number of
scales makes detection more computationally heavy. Increasing the number of scales to over 30 is not
beneficial for detection.

� Threshold match: Sets the threshold matching score for object detection (between 0 and 1). Only
matches with a score higher than the threshold are counted as objects. If you have many false negatives,
try decreasing the threshold match.
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After choosing your detection settings, press Run Detection to run the MTM vesicle detection. Pay
attention that the template and target image are preprocessed in a similar way, as this leads in general
to the best detection. When the process is finished, you will see detected vesicles indicated with square
bounding boxes (fig. 10) and vesicle index numbers. The size of the boxes resemble the scale of the template
that resulted in the highest matching score.

Troubleshooting 4.2: MTM detection

� Too many objects detected. When detection returns many false positives, increase
Threshold match to filter out matches with a low matching score.

� No vesicles detected. When no vesicles are detected, first inspect your template by clicking
Show template. Make sure that the template corresponds to the objects you wish to detect.
Also, make sure that the template has the same intensity profile: did you apply the same pre-
processing options to both the template and the image? Then, verify that your template scaling
options are chosen properly. If still no vesicles are detected, decrease the Threshold match to
allow detection of objects with lower matching scores. You can also increase Number of scales,
although more than 30 scales are in general not required for detection.

� Bounding box positioning. You can try to make detection bounding boxes more or less
narrow by changing the template selection. When the template bounding box is drawn just
around the template vesicle, i.e. minimal space between the membrane and edge, detection will
result in bounding boxes that are equally narrow. Vice versa, larger bounding boxes can be
obtained by creating a larger template.

Display of the detection results can be toggled on and off by hitting Hide Detection and Show Detection.
Furthermore, you can switch between displaying the original image or the enhanced image by clicking
Original Image or Current Image. Detection results can be saved internally by clicking Save.

4.2.3 FF: Floodfill Detection

The floodfill detection method is particularly useful for fluorescence images, where the membrane signal
delineates vesicle contours. In floodfill detection, the image is thresholded to retain a foreground image
containing the membrane signal. Then, all background pixels contained by a closed contour of foreground
pixels are counted as vesicles.

It is advised to proceed the floodfill detection with both a smoothing and edge enhancement step. This
helps to close membrane contours, and thereby increases the number of vesicles that will be detected.
Furthermore, preprocessing will help to create a sharper contour of the vesicle, resulting in a more well-
defined boundary of the detected object.

Quick Instructions 4.4: FF detection

[Menu] -> Vesicle Detection -> Floodfill

[Floodfill] -> Smooth Image

[Floodfill] -> Enhance Edges

[Floodfill] -> Detect vesicles

Open the Floodfill tab in the Vesicle Detection window (fig. 11a). Enable both Smoothing and
Enhancement options in the detection window to preprocess the image. The settings as specified in the
Membrane Enhancement window under Floodfill will be used. We recommend using a small smoothing
filter size to minimise signal cross-over between vesicles. The edge enhancement filter size should be chosen
large to reduce large-scale intensity variations. By default, the size of the smoothing and enhancement filters
are 5 and 105, respectively.

Inspect your image: you should see sharp white lines delineating the vesicle contours. From the enhanced
image, you can proceed with detection. Two parameters can be tuned:
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(a) Preprocessed image
(b) Ff detection panel

(c) Thresholding

Figure 11: Thresholding procedure for floodfill detection. The floodfill detection panel can be opened
from the vesicle detection menu (a). The panel contains all options for image preprocessing, thresholding
and detection (b). After image preprocessing, the image can be thresholded (c). The thresholded image
should contain sharp vesicle contours which are closed around the entire vesicle circumference. This is the
starting point for floodfill detection.

� Threshold: The relative global intensity threshold used for binarisation of the image, prior to detection.
The number in the input widget (between 0 and 100) is used as a percentage of the maximum intensity.

� Minimal Size: The minimal area of objects to be detected. The number in the widget represents
the one-dimensional size of the object, meaning that the default minimal area of 100 in fact means a
minimal object size of 10000 pixels.

First, select the intensity threshold to separate membrane signal from background signal. Press Show threshold

to inspect the thresholding. If chosen correctly, the membrane shows as a sharply defined white signal on a
black background (fig. 11c). Contours should be connected around the entire vesicle circumference, leaving
no openings. Then, select the minimal area of objects to be detected and press Detect vesicles to run
detection.

When detection is finished, detected vesicles will be displayed in the image by coloured masks with vesicle
index numbers (fig. 12). Numbering of vesicles goes from the top of the image to the bottom. Coloured
patches represent the exact mask that overlay the detected object. Note that FF is a shape insensitive
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Figure 12: FF detection result. Detected vesicles are labelled with coloured masks. Note that floodfill
detection also successfully identified vesicles at the edge of the image.

detector and is thus able to detect objects of different morphologies. Even when all vesicles have been
detected, you may sometimes still want to tune further the Floodfill detection parameters. For example, the
contour of the detection mask varies with the detection settings. To fine-tune the detection masks, use the
preprocessing filters and the threshold value (Troubleshooting 4.3).
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Troubleshooting 4.3: FF detection

� Image turns white or black. When the entire image turns white or black, this means that all
pixels are either above or below the set threshold. Change Threshold and click Show Threshold

to inspect your result. Note that the threshold is a percentage and should thus not be compared
to absolute intensities.

� Openings in thresholded contour. Floodfill detection strongly relies on closed vesicle con-
tours in the thresholded image. Any contour that is not completely closed will not be detected
as a vesicle. When contours have a speckled appearance, try to increase Smooth filter size

or Enhancing filter size. If contours appear smooth but have larger openings, decrease
Threshold.

� Detection masks do not cover the entire vesicle lumen. When membrane signal bleeds
into the vesicle lumen in the thresholded image, this affects the quality of the detection mask.
To make sure that the vesicle contour is sharply delineated, first make sure that you use a
small Smooth filter size and a larger Enhancing filter size. Increasing the Threshold

narrows down the thickness of the contour, but be careful to keep the contour closed. When
membranes have varying thickness in the thresholded image, decrease Enhancing filter size.

� Smaller vesicles are not detected. Decrease Minimal area to allow detection of smaller
vesicles.

� Touching vesicles are not detected. Decrease Smooth filter size to prevent signal bleed-
through between touching vesicles.

The display of floodfill detection masks can be tuned on or off by clicking Hide Mask or Show Mask, and
you can toggle between the original and current image by clicking Original Image and Current Image.
Results can be saved with the Save button.

4.3 Choosing your detection method

As a user, you will have to choose which of the three detection methods fits your needs best. Although
you can make an informed decision based on the method’s characteristics, it is still useful to try all different
methods on your data set. It should take not more than 15 minutes to get a first idea of how all three detectors
perform. Here, we summarise the main characteristics of all methods - for a comprehensive characterization,
we refer you to the DisGUVery paper.

4.4 Deleting detected vesicles

Sometimes, you may want to exclude detected vesicles from further analysis, for example false positives or
vesicles with an undesired phenotype. To remove vesicles from the detection results, go to Vesicle Detection

and click on Select and Delete, or use the shortcut Ctrl+d. The display changes to selection mode: the
index numbers of vesicles in the image change colour, from yellow to blue. To select a vesicle, click on
its index number. Its index number changes colour to pink. To confirm deletion, right click in the image.
The vesicle is now permanently deleted from the detection results, and the display is updated immediately.
Likewise, multiple vesicles can be discarded at once by selecting multiple objects when in selection mode.
To exit Selection Mode, click again on Select and Delete under Vesicle Detection, or press Ctrl+d.

Quick Instructions 4.5: Select and Delete

[Vesicle Detection] -> Select and Delete (Ctrl+d)
-> Left click to mark vesicles for deletion
-> Right click to discard selected vesicles
[Vesicle Detection] -> Select and Delete or (Ctrl+d)
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4.5 Exporting results

Detection results can be exported to be used outside the DisGUVery environment. This can be useful for
example if you want to do your own custom-written analysis outside the software. Note that you always first
have to save your detection results before you can export them!

Exporting is done with the Export as .csv option in the dropdown menu Vesicle Detection. To
export the results of the current image, click Current. A file dialog automatically opens up. Specify the
name of your output file and select the folder where you want to save your detection results. Click Save and
the results will be exported into a single .csv. If you want to save results from all processed images, then
go to Export as .csv and click All. Select a folder and click Save. Results will be exported as .csv files,
a single file for each image. The .csv extension is added automatically.

Results from Circular Hough detection are exported as an array with for each vesicle a row containing
the x- and y-coordinate of the centre detected circle xc, yc, and its radius r. The export results follow the
vesicle indexing in the detection, with the results of vesicle 1 stored in the second row, below the header.

For Multiscale Template Matching, results are saved for each vesicle in a separate row, starting with the
vesicle with the highest matching threshold in row 2, below the header. For each vesicle, stored results are
the centre coordinates of its bounding box xc and yc, the size of the box i.e. the length of its edges, and the

(a) Activate Selection Mode (b) Mark vesicles for deletion

(c) Discard vesicles

Figure 13: Select and delete unwanted vesicles. Enter the Selection Mode (a), vesicle index numbers
change to blue. Left click on vesicles to mark them for deletion (b). Their index numbers change to pink. In
this example, vesicle 3, 5 and 15 have been selected. Then, right click to permanently discard vesicles (c).
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(a) Opening the export wizard

Figure 14: Exporting detection results. After vesicle detection, results can be exported into a csv file
for post-processing outside the DisGUVery environment.

matching score.

Quick Instructions 4.6: Exporting Detection Results

-> Save detection results
[Vesicle Detection] -> Export as .csv -> Current

-> Select folder and give in filename
-> Save

Exporting floodfill detection results gives you in addition to a .csv also a .tif file for each image. The
.csv file contains vesicle index numbers, the x- and y-coordinate of the centre of the mask xc and yc, and
the length of the major axis of the mask. The .tif file is array with the same dimensions as the image,
where the detected masks are depicted in their true locations. While all background pixels have value 0, the
pixels of each vesicle mask have the value of the index number of the corresponding vesicle.

20



5 Membrane Segmentation

On top of vesicle detection, DisGUVery allows for further segmentation of the membrane of detected vesicles.
There are two ways to segment the membrane: Basic Segmentation and Refined Detection. Basic Segmenta-
tion is suitable for fast and coarse analysis, and assumes a spherical shape of the vesicles. Refined Detection
involves an extra membrane detection step, leading to a more precise segmentation. This is of particular
interest for non-spherical vesicles, or when segmentation has to be performed with a higher spatial accuracy.
Both analysis modes can only be accessed after vesicles have been detected and results have been saved.

(a) Opening the Basic Segmentation window (b) Display changes

(c) Settings

(d) Results

Figure 15: Basic Segmentation procedure for Hough detection. After vesicle detection, here done by
Hough detection, open the Basic Segmentation window (a). Once the window opens, the display of vesicle
detection results becomes dimmer (b). Tune the settings in the Basic Segmentation window (c) and press
run to create the segmentation masks. The inner and outer segmentation boundaries are shown in light blue
and dark blue, respectively.

5.1 Basic Membrane Analysis

Basic segmentation works slightly different for CHT detection as compared to MTM and Floodfill. In CHT
detection, the segmentation ring is drawn concentric with the circular vesicle detection result, essentially
widening the circular vesicle detection ring. The exact position of the segmentation ring depends on its
width and relative contour position, both specified by the user. In MTM and FF, the vesicle detection result
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is first converted to a square bounding box. For MTM, the bounding box is identical to the bounding box
that results from detection. For FF, the box is drawn around the detected mask, using the mask’s major
axis length as the box size. Using this box, the segmentation ring is created with specified width, using
the box edges either as the inner edge, outer edge or centre of the segmentation ring. To accommodate for
offsets between the bounding box edge and the vesicle membrane, for example due to a template that was
chosen too large, the software allows to offset the segmentation ring with respect to the box edges.

� Membrane width: Width of the segmentation ring in pixels.

� Contour position: Position of the segmentation ring with respect to the approximate contour found
by vesicle detection. If chosen Inside, the vesicle detection result is taken as the inner boundary of the
segmentation ring, if chosen Outside, the vesicle detection result is taken as the outer boundary, and
if chosen Middle, the segmentation is centred around the vesicle detection radius. Switching between
contour positions can be useful when studying fluorescence at different locations with respect to the
membrane, for example in the extracellular solution, for membrane dyes, or for encapsulates.

� Offset bounding box: Only used when vesicles are detected with Floodfill or Template Matching.
The segmentation ring can be positioned with an offset to the bounding box edges. This can be useful
when one wants to analyse the content of a vesicle instead of its membrane, or when the bounding box
is larger than the vesicle diameter.

(a) Preprocessed image (b) Ff membrane detection panel

Figure 16: Basic Segmentation procedure for Floodfill and Template Matching. Performing BMA
in combination with FF or BMA allows for an extra offset option. After vesicle detection, here done by
Floodfill detection, open the Basic Segmentation window. Once the window opens, bounding boxes are
created around the detection results (a). Tune the settings in the Basic Segmentation window and press run
to create the segmentation masks. Use the offset to offset the ring position with respect to the box. The
inner and outer segmentation boundaries are shown in light blue and dark blue, respectively (b).

Quick Instructions 5.1: Basic Segmentation

-> Save Vesicle Detection Results
[Membrane Segmentation] -> Basic Segmentation

[Membrane Segmentation]-> Specify Width and Contour Position

[Membrane Segmentation]-> Run

[Membrane Segmentation]-> Save
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5.2 Refined Membrane Detection (RMD)

When a more precise, non-circular membrane segmentation is required for your analysis, you can better
make use of the Refined Detection module. Go to [Membrane Segmentation] -> Refined Detection

(fig. 17a). A new window opens with the membrane detection options (fig. 17b). Upon opening the window,
also the vesicle detection results are displayed in a dim grey colour (circles for CHT, boxes for MTM and
FF).

(a) Open the Refined Detection window
(b) Settings

(c) Create the edge mask (d) Edge mask zoom-in

Figure 17: Refined Segmentation: creating the edge mask. After saving the vesicle detection results,
open the Refined Detection window (a, b). Create the edge mask (c). The edge mask shows a double set of
points for each membrane, delineating the inner and outer contour (d).

Prior to membrane detection, an edge mask needs to be created. To do so, specify the Filter and
Threshold:

� Filter: Size of the Gaussian filter for edge detection. Larger filters create more smooth edges that
are spaced further from the actual membrane position.

� Edge Threshold: Threshold for edge detection. Increasing the threshold can help to filter out false
edges, while a lower threshold allows to find edges that are otherwise missed.

It is useful to use the membrane enhanced image for edge detection, as preprocessing generally yields a
higher quality edge mask. Press Mask to compute the edge mask. The mask will be displayed in orange on top
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of the working image. The edge mask should contain for each membrane a double set of points, delineating
the membrane’s inner and outer contour (fig. 17d). These points will be used for further membrane detection.

(a) Select a vesicle (b) Membrane detection result

(c) Detection colors

Figure 18: Refined Segmentation procedure: detect the membrane. After creating the edge mask,
select a vesicle to detect its membrane (a). Detection yields two sets of edge points (b), being the inner and
outer edge displayed in light blue and dark blue, respectively.

To detect the membrane, specify the settings under Membrane Detection in the Refined Membrane Detection

panel (fig. 17b). We advise to first analyse a single vesicle, to check if the settings are right. To do so, click
Select and Detect. The vesicle ID’s become blue. Select a vesicle to detect its membrane. Its ID changes
colour to pink. Note: make sure none of the options of the image toolbar are enabled, as this prevents the
selection of vesicles. To confirm selection and initiate membrane detection, press again Select and Detect.
When detection has finished, the results are displayed in the main window. Detection yields two contours:
an inner contour (light blue) and an outer contour (dark blue) which together shape the segmentation area
(fig. 18b). Edges that are not assigned to the inner or outer contour, are coloured red (fig. 18c). To add
membrane detection for a second vesicle, click again Select and Detect and follow the same procedure.
Results for both vesicles will be stored as long as the Refined Membrane Detection panel is open. To save
the segmentation for further use, click Save. Closing the panel with the Close button (not the X) clears the
display and erases any unsaved detection results.
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Quick Instructions 5.2: Refined Membrane Detection

-> Save Vesicle Detection Results
[Membrane Segmentation] -> Refined Detection

[Refined Detection] -> Mask

[Refined Detection] -> Select and Detect

[Refined Detection] -> Select vesicles to detect contour
[Refined Detection] -> Select and Detect

[Refined Detection] -> Save

Instead of analysing one vesicle at a time with Select and Detect, you can also analyse multiple vesicles
at once. To do so, click Select and Detect, select multiple vesicles, and confirm the total selection by
clicking again Select and Detect. Detection will run automatically for all selected vesicles. To save the
segmentation for further use, click Save.

Membrane detection can also be executed for all detected vesicles at once. To do so, use the Run on Image

option. Note that this step can take some time, as RMD is one of DisGUVery’s more computationally heavy
algorithms. Results can be used for further analysis by saving them using the Save button.

� Bbox Margin: Extra margin for the confining bounding box. For each vesicle, only edges inside the
bounding box are considered for detection. Increasing the size of the bounding box can help to make
sure that all necessary edge points are confined.

� Detection Threshold: Normalized threshold within the bounding box. Useful when vesicle contours
have different gradients.

� Search Size: Length (pixels) of the search box that is used to connect edge points.

� Search Width: Width (pixels) of the search box.

5.3 Choosing your membrane analysis method

Whether to use BMA or RMD for your membrane segmentation depends on the desired spatial accuracy and
image quality. While BMA is less accurate for tracking exact membrane boundaries, it is computationally
cheap and needs minimal visual inspection. With RMD, membranes can be tracked ore precisely, but you
might need to analyse vesicle-by-vesicle to ensure correct tracking. Check the paper for a comprehensive
overview.
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6 Analysis

6.1 Vesicle Size distribution

After vesicle detection, you can directly plot vesicle size distributions in the software. To do so, first save your
detection results (see section 4). Then, go to the Analysismenu and open the Vesicle Size Distribution

window. A size distribution is directly generated (fig. 19a) and displayed. You can toggle between the size
distribution from all images, or the current image only using the Current and All Images buttons in the
top of the screen. Bin sizes and the plot minima and maxima can be tuned in the bottom of the window.
After changing plot settings, always press Update to produce the new plot. Export the histogram values by
clicking Export as .csv.

(a) Generate a size distribution (b) Gaussian fit to the distribution

Figure 19: Size distributions. After vesicle detection, size distributions can be generated from the current
image or all analysed images (a). The distribution can be fitted with a Gaussian and the results can be
exported (b).

To fit a Gaussian to your size distribution, press Fit Data. This gives a plot of the fit (in purple) as well
as the Gaussian mean, standard deviation and the number of vesicles. Keep note that DisGUVery currently
only works with x-y images and not z-stacks. For generating more accurate size distributions, we recommend
to try using maximum projections of z-stacks.

6.2 Encapsulation Efficiency

Using the Encapsulation Efficiency module, you can compute the average signal intensity of the lumen
of detected vesicles. From the Analysis menu, select Encapsulation Efficiency and the corresponding
window will open.

DisGUVery uses masks to segment the vesicle lumen for calculation of the intensity metrics. You can
directly use the masks that are generated by the vesicle detection output. In that case, analysis is per-
formed with a spherical mask for vesicles detected with CHT and MTM (using the bounding box size
as radius), and the detected contour for FF detection. To directly use the vesicle detection mask, press
Show Detection Mask. The masks are now overlaid on top of the image, shown in yellow.
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Quick Instructions 6.1: Encapsulation Efficiency

-> Save Vesicle Detection Results
[Analysis] -> Encapsulation Efficiency

-> Show Detection Mask

-> Run

-> Export Results and Mask

(a) Assign the membrane and content channels (b) Open the encapsulation panel

(c) Show the detection masks (d) Run encapsulation analysis

Figure 20: Encapsulation analysis: basic. Prior to analysis, make sure you select assign the channels in
the channel manager. Here, red (ch2) is membrane, white (ch1) is content. (a). Detect vesicles (here CHT)
and save the results, then open the Encapsulation Efficiency window (b). Show the mask created from the
vesicle detection (c). Press run to obtain the average intensity of the content of each vesicle, the results of
which are displayed on top of the image (d).

When you are not satisfied with the vesicle detection results to mask the vesicle lumen, you can choose
to refine the mask. This extra step entails a floodfill-based detection of the vesicle lumen, meaning that for
each detected vesicle, a floodfill segmentation is performed in a bounding box around that vesicle to separate
the lumen from the membrane signal. Make sure that the right image is used for refinement: depending
on the data quality, it might be best to use the raw image or a processed version. See section 4.2.3 for
more instructions on floodfill detection. Choose an intensity threshold, typically between 0 and 5. Click
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Refine Vesicle Mask to compute the masks and inspect the results in the main window. You can further
fine-tune the masks by changing the intensity threshold.

(a) Create the refined masks (b) Compute intensities

Figure 21: Encapsulation analysis: refined masking. To refine your masks, specify a threshold and
click on refine. The refined masks will be shown in the main display (a). Press run to use the refined masks
for computing the average intensities (b).

After choosing the best masking method, the intensities can be extracted. Make sure you select the right
background correction method:

� None: No background correction at all (default);

� Image mean: Subtraction of the mean intensity in the image;

� B.Box corner: Subtraction of the average intensity in the bounding box corners;

Then, to compute the average intensity per vesicle, press Run. Intensities are automatically calculated
from the masks and the averages are displayed on top of the image. The intensity calculation is done only in
one single channel, namely the first channel annotated as encapsulated content (see section 3.2.2). Finally,
the results can be exported by clicking Export results and mask. Exporting yields two files: a .csv file
containing vesicle IDs, locations, average intensity and mask size, and a .tif file containing the masked
pixels and the corresponding intensities. Note that the first region of interest (id=0) corresponds to the
background.

6.3 Intensity Profiles

You can extract angular and radial fluorescence profiles from detected vesicles, to map for example membrane
fluorescence or membrane-binding of a fluorescent protein. Intensity profiles can be computed directly from
vesicle detection results, from basic segmentation, or from refined detection.

Open the Intensity Profiles window from the Analysis menu. Upon opening the panel, the current
membrane segmentation (BMA as rings, RMD as contour points) is displayed in the main window. If no
membrane segmentation results (BMA or RMD) results have been found, the software used the vesicle
detection results (circles for CHT, boxes for MTM and FF).

To compute the intensity profiles for a single vesicle, press Inspect Vesicle in the bottom of the panel.
The vesicle IDs change colour to blue, and you can now click on a vesicle to select it. Its label changes
to pink, and the intensity profiles are computed and are displayed in the Intensity Profiles window.
Multiple vesicles can be selected at once to analyse them together. When selecting a vesicle, make sure that
the none of the image toolbar options are enabled.
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(a) Perform your membrane segmentation and open the
Intensity Profiles panel

(b) Specify settings

(c) Select vesicles

(d) Resulting profiles

Figure 22: Computation of intensity profiles. Detect vesicles (here CHT), save the results, and select
membrane segmentation method (here BMA). Then open the Intensity Profiles window (a). Specify the
integration settings in the window (b) and select a vesicle, which is marked in pink (c). The software
automatically computes the profiles which are displayed in the two plots (d).

The Intensity Profiles window shows two plots. The top plot shows the angular profile of fluorescence,
and in case of RMD segmentation also the angular profile of radial distance, and the bottom plot shows
the radial profile. To switch between calculating only the angular profile, only the radial profile, or both,
use the Enable option found with both profiles. For each profile, the integration step size can be set by
specifying the number in the widget d θ (deg) and dr (pix). Plots are annotated with the vesicle ID,
and, if applicable, the channel number - e.g. for vesicle 5, channel 2, the label is v5c2. The plots that were
generated last are fully opaque, older profiles are dimmed.

Both fluorescence profiles show the mean intensity per slice (angular or radial). The software allows for
multiple ways to correct for background fluorescence:

� None: No background correction at all (default);
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� Image mean: Subtraction of the mean intensity of the whole image, on the selected channel;

� ROI mean: Subtraction of the mean intensity of the vesicle ROI, i.e. the bounding box used for profile
computation;

� ROI corner: Subtraction of the mean intensity of 3x3 pixels squares on all four corners of the bounding
box;

� ROI center: Subtraction of the mean intensity of a 3x3 pixel square in the ROI centre.

Note that profiles can be normalized per vesicle. Normalisation of the radius is done using the mean
radius of the selected vesicle. Intensities are normalized using per vesicle the mean of the mean intensities
of all slices.

For multicolour images, the profiles of the different channels can be computed. Include the desired
channels by checking their respective boxes in the Angular Profiles and Radial Profiles window. The
background correction can be specified for each channel separately.

(a)

(b) Specify settings

Figure 23: Intensity profiles in multichannel images. Prior to computing the intensity profiles, in
multichannel images make sure you assign the channels in the channel manager (see fig. 20). Detect vesicles
(here CHT), save the results, and select membrane segmentation method (here BMA). Select a vesicle, which
is marked in pink (a). The software automatically computes the profiles from both color channels (b).

Calculation of angular profiles is performed differently whether the fluorescence signal localizes to the
membrane or is distributed throughout the lumen. For membrane-bound signal, the angular profile is
computed only in the membrane segmentation ring (for RMD and BMA), so between the inner and outer
segmentation radius. For signal not bound to the membrane, the angular profile is computed from all the
signal in each angular slice, from the vesicle centre up to the outer radius. Specify the membrane localization
using the Channel Manager (section 3.2.2): signal assigned as membrane signal or membrane-bound signal

will be considered membrane-bound signal. Furthermore, if there are multiple colour channels and the
channel manager is not used, the channel in which the segmentation is performed is automatically assigned
as membrane signal. This is flagged by a message in the terminal .

Be careful from which image you compute the intensity profiles, as the software will automatically calcu-
late from the working image which might be preprocessed with smoothing or enhancement steps. To derive
the profiles from the original image, first reset the image (Ctrl + r) before computing the profiles. After
displaying the intensity profile for a vesicle or a set of vesicles, you can go back to Inspect Vesicle to add
the results of other vesicles. To clear all intensity profiles, right click in the main window. To clear the main
display, press Close on the Intensity Profiles panel.
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Quick Instructions 6.2: Intensity Profiles

-> Save vesicle detection results
-> Save membrane segmentation results
Analysis -> Intensity Profiles

[Intensity Profiles] -> Inspect Vesicle

[Intensity Profiles] -> Select vesicle(s)

[Intensity Profiles] -> Export Data

Fluorescence profiles can also be calculated for all detected vesicles at once. To do so, press Run on Image.
Note that this computation can take several seconds. Finally, intensity profiles can be exported using the
Export Data button. Specify the folder where the results should be saved and click Save. Exporting yields
a maximum of three .csv files depending on the settings chosen: one for radial intensity profiles, one for
angular profiles, and one for angular distances. The export of the fluorescence profiles contain vesicle ID,
colour channel, angle/radius, mean intensity, minimal intensity, maximum intensity and sum intensity. The
angular distance export contains the vesicle ID, angle, and inner and outer radius of the double contour
generated with RMD.
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7 Batch Processing

If you have a larger number of images to analyse, you might want to speed up analysis by using the Batch
Processing functionality. DisGUVery’s Batch Processing functionality allows you to analyse all the loaded
images at once with a pre-defined workflow.

To open the Batch Processing window, go to Batch Processing -> Multi-image Processing (fig. 24).
In the window, you find all the functionalities for image preprocessing, vesicle detection, membrane segmen-
tation and analysis that have been discussed before in this guide. Here, you can specify the workflow that
will be applied to all the available images. By enabling or disabling different functionalities, you can assemble
the workflow that works best for your data set. The settings that are used by each functionality are not
specified in this window, but are taken from the separate windows of each module.

Figure 24: Batch Processing allows for high-throughput analysis. In the Batch Processing window,
you can assemble a workflow and use it to analyse multiple images at once.

Load your data set into the File Manager. Make sure that all files have the same structure (x, y, c) and
preferably the same extension and data type. Specify the channel settings in the Channel Manager (see
section 3.2.2). Review your data set in the File Manager using the Preview setting. Remove images from
the list if necessary. Before you can start batch processing, first identify the analysis workflow for a single
image. Use the separate modules to analyse a single image. Then, check if the same settings can be used
to analyse one or more other images. Navigating between different images can easily be done using the File
Manager and the Set as Current option. If you are convinced that your settings robustly yield the results
that you aimed for, and do not lead to excessive computation times, open the Batch Processing window.

In the Batch Processing menu, select which Pre-processing options you would like to incorporate prior
to vesicle detection, by enabling or disabling the Filter and Membrane Enhancement options. Note that for
each module, the software uses the settings as specified in the separate module windows: thus, to change e.g.
the membrane enhancement filter size, open the Membrane Enhancement panel (see section 4.1) and change
the filter size there. Upon closing the module window, settings are updated automatically. After selecting
the preprocessing settings, choose your vesicle detection method from the dropdown list, and specify the
channel to be used for membrane detection. Enable Export if you wish to export your detection results
(see section 4.5). Select the intensity profiles you wish to generate by clicking the appropriate channel
buttons from the Angular or Radial options. The intensity profiles can be computed from segmentation
based on the vesicle detection results (default), or using BMA (see section 5.1). To use BMA, click Enable
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in the Membrane Segmentation menu. Note that in the current version, RMD is not supported for batch
processing. You can then choose to enable the computation of the vesicle size distribution, and/or the
calculation of encapsulation efficiency. For the Encapsulation Efficiency, make sure to choose if you want
to use the Detection Mask or the Refined Mask. Select from which channels the encapsulation should be
computed. Finally, click Choose Folder to specify the directory where the exports should be saved.

Quick Instructions 7.1: Batch Processing

-> Load images to analyse
-> Set channels in Channel Manager -> Specify settings in module windows
Batch Processing -> Multi-image processing

[Batch Processing] -> Specify workflow
[Batch Processing] -> Test on Current Image
-> Evaluate results
[Batch Processing] -> Run

Once you have assembled your workflow, click Test on Current Image. The entire analysis will be
performed on the Current Image only, allowing you to inspect the results and the export files before running
the analysis on your entire data set. If needed, modify the workflow, or the settings of the different modules,
and test the workflow on the current image until you are satisfied. Once you are all set, click Run to
analyse all the loaded images one by one. Keep track of the terminal to see follow the progress. During
Batch Processing, the main display is not updated, but vesicle detection results are stored in the software.
Intensity Profiles and Encapsulation Efficiency are exported on the fly as flagged in the terminal. When
all files are analysed, the vesicle size histogram is displayed, compiling the results for all images analysed.
The histogram can now be exported (see section 6.1). To inspect the vesicle detection results of processed
images, select an image in the File Manager, set it as Current, and open the Vesicle Detection window.
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8 Input and output

extension .tif, .tiff, .png
colour channels up to 4

Table 1: Supported input formats.

Analysis method .csv .tif

Vesicle detection CHT ID, xc, yc, r
MTM ID, xc, yc, l
FF ID, xc , yc, lmajor detection mask

Size distribution bin (vesicle size), counts
Intensity profile angular ID, channel, Θ, Imean, Imax, Imin, Isum

radial ID, channel, ri, Imean, Imax, Imin, Isum
Encapsulation ID, channel, xc, yc, Imean, A encapsulation mask

Table 2: Export options. ID: vesicle index number, xc, yc: x and y coordinate of vesicle centre, r: vesicle
radius (CHT), l: vesicle bounding box axis length (MTM), lmajor: vesicle major axis length (FF), Θ:
integration angle, Imean: mean intensity in integration slice or under encapsulation mask (a.u.), Imax:
maximum intensity in integration slice (a.u.), Imin: minimum intensity in integration slice (a.u.), Isum
summed intensity over all pixels in integration slice (a.u), A: number of pixels under encapsulation mask.
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